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The wavelength and frequency are two characteristics of electromagnetic radiation which are 
particularly important for understanding remote sensing and the information to be extracted from 
remote sensing data.

The wavelength is the length of one wave cycle, which can be measured as the distance between 
successive wave crests. It is represented by the Greek letter lambda (  ). It is measured in meters (m) 
or some factor of meters such as nanometers (nm, 10-9metres), micrometers (10-6metres) or 
centimeters (cm, 10-2metres).

Frequency refers to the number of cycles of a wave passing a fixed point per unit of time. It is 
measured in hertz (Hz), equivalent to one cycle per second, and various multiples of hertz. 

Wavelength and frequency of electromagnetic energy are inversely related to each other. The shorter 
the wavelength, the higher is the frequency and the longer the wavelength, the lower is the 
frequency. The following equation provides the relationship between wavelength and frequency of 
electromagnetic energy.
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Wavelength and Frequency

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.



 
 

 

Viewer 

 
Import 

Import/Export Dialog Box 
 

Import - Select this button if you are importing data into ERDAS IMAGINE 
 

Export - Select this button if you are exporting an ERDAS IMAGINE file into another format. 

Type: Click on this dropdown list and select the data type to import or export. When 
Import or Export is selected, the list of import or export data types display. 

Media: Click this dropdown list to select the media from which you are importing: CD-
ROM, Tape, or File. Not all data types can be imported from all media types. A warning 
displays when a Type-Media mismatch occurs. 
Input File: Enter the name of the input file.  
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The ERDAS IMAGINE Viewer is the "main window" for displaying raster, vector, and/or 
annotation data. An IMAGINE Viewer opens automatically when IMAGINE starts. Also, you may 
use the File > New menu to start a Viewer.

You may start additional Viewers of the default type by clicking the Viewer icon on the IMAGINE 
icon panel. Viewer can be resized by dragging a corner or side. Both viewers have a Main Toolbar 
that is always visible.

With the help of this menu a large number of data of raster and vector file formats are imported 
from file, CD-Rom or Tape into ERDAS IMAGINE and exported and ERDAS IMAGINE file 
into another format. This dialog enables you to import or export virtually any type of data to or 
from ERDAS IMAGINE.

1. Introduction to Remote Sensing and ERDAS IMAGINE1-14

Output File: Enter the name for the output file (the name of the file in ERDAS IMAGINE).
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Resolution
Resolution is used to describe the area on the ground that a pixel represents in an image file.
Four distinct types of resolution must be considered : 

Spatial  -  area on the ground represented by each pixel 

Spectral  -  specific wavelength intervals that a sensor can record

Radiometric - number of possible data file values in each band

Temporal - how often a sensor obtains imagery of a particular area. 

These four domains contain separate information that can be extracted from the raw data.

Spatial Resolution
Spatial resolution is a measure of the smallest object that can be resolved by the sensor, or the area 
on the ground represented by each pixel (Simonett et al, 1983).For a homogeneous feature to be 
detected, its size generally has to be equal to or larger than the resolution cell. If the feature is 
smaller than this, it may not be detectable as the average brightness of all features in that resolution 
cell will be recorded.

Large-scale in remote sensing refers to imagery in which each pixel represents a small area on the 
ground, such as SPOT data, with a spatial resolution of 10 m or 20 m. Small scale refers to imagery 
in which each pixel represents a large area on the ground, such as Advanced Very High Resolution 
Radiometer (AVHRR) data, with a spatial resolution of 1.1 km.  

http://www.satimagingcorp.com/services/resources/charact
erization-of-satellite-remote-sensing-systems  
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Source: ERDAS IMAGINE on line Help for the Zooming Tools

Zooming Tools 
Zooming is the magnification or reduction of an image in the Viewer. Zooming has no effect on 
how the image is stored in a file. 
 

The quick zoom buttons, and , enlarge and reduce the image without changing the 
center of the viewable area 

The zoom tools, and , enlarge and reduce the image and also shift the image so that the 

clicked spot is in the center of the Viewer. When the tool is selected, you can drag a box 
around an area within the Viewer and when the mouse button is released, that area magnifies so 

that the enclosed area fits entirely within the Viewer. When the tool is selected and a box is 
dragged, the entire Viewer area is reduced so that it fits completely within the bounding box. 

There are also options on the View > Zoom submenu (In By X... and Out By X...) that allow 
you to specify the exact zoom ratio (1.37 for example) and to specify or change the resample 
method. 
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Agriculture Application
Agriculture plays a dominant role in economies of both developed and underdeveloped countries. 
Producing food in a cost-effective manner is the goal of every farmer, large-scale farm manager and 
regional agricultural agency. Satellite and airborne images are used as mapping tools to classify crops, 
examine their health and stress, and monitor farming practices.

Remote sensing offers an efficient and reliable means of collecting the information required, in order 
to map crop type and acreage. Optical remote sensing can see beyond the visible wavelengths into 
the infrared, where wavelengths are highly sensitive to crop health and stress and crop damage. 
Remote sensing can aid in identifying crops affected by too dry or wet conditions, affected by insect, 
weed or fungal infestations or weather related damage. Following are the lists of few remote sensing 
applications for agriculture:   

crop type classification

crop yield estimation

crop condition assessment

mapping of soil characteristics 

mapping of soil management practices 

management practices 
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Pattern
Pattern means arrangement of individual objects into distinctive recurring forms that facilitate their 
recognition on imagery. The buildings in an industrial plant may have a distinctive pattern due to 
their organization to permit economical flow of materials through the plant, from receiving raw 
material to shipping of the finished product. The distinctive spacing of trees in an orchard arises 
from careful planting of trees at intervals that prevent competition between individual trees and 
permit convenient movement of equipment through the orchard.  

Association
Association takes into account the relationship between other recognizable objects or features in 
proximity to the target of interest. The identification of features that one would expect to associate 
with other features may provide information to facilitate identification. In the example given above, 
commercial properties may be associated with proximity to major transportation routes, whereas 
residential areas would be associated with schools, playgrounds, and sports fields.  

Source:
Wynne, James B. Campbell, Randolph H. (2011). Introduction to remote sensing (5th ed.). New York: Guilford Press.

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing

 



Cubic Convolution 
Cubic convolution is similar to bilinear interpolation, except that a set of 16 pixels, in a 4 × 4 
array, are averaged to determine the output data file value, and an approximation of a cubic 
function, rather than a linear function, is applied to those 16 input values. The effect of the cubic 
curve weighting can both sharpen the image and smooth out noise (Atkinson, 1985). The actual 
effects depend upon the data being used. 
 
This method is recommended when you are dramatically changing the cell size of the data, such as 
in TM/aerial photo merges (i.e., matches the 4 × 4 window more closely than the 2 × 2 
window).Data values may be altered. This method is extremely slow. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC

 
 

 

Rectification Summary  Rectification or geo-referencing is essential for almost all remote sensing projects. It allows image 
to correspond to real world map coordinates. It is required for combining imagery and GIS. It is 
essential for obtaining spatially accurate products—requires considerable care. 
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Problems: Original pixel value integrity lost; slowest
Benefits: Sharpen images and smooth noise
Uses: Resampling large cell size differences  
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The electromagnetic spectrum consists of all the different wavelengths of electromagnetic radiation 
ranges from the shorter wavelengths (including Gamma and X-rays) to the longer wavelengths 
(including Microwaves and broadcast radio waves). There are several regions of the electromagnetic 
spectrum such as visible spectrum, infrared spectrum and microwave spectrum, which are useful for 
remote sensing.

The electromagnetic energy which our eyes can detect is part of the visible spectrum. The visible 
spectrum of electromagnetic energy covers a range of wave length from 0.4 to 0.7. The longest 
visible wavelength is red and the shortest is violet. There is a lot of electromagnetic energy around 
us which is "invisible" to our eyes, but can be detected by other sensors and used to our advantage.    
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Electromagnetic Spectrum

Visible Spectrum

Source: http://ls7pm3.gsfc.nasa.gov/whatsRM/em.html 

Source: http://www.faculty.virginia.edu/rwoclass/astr1210/121supps2-3.html 

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.



  

 
Data Preparation 

 
This menu gives you access to a set of tools that are useful in general data preparation. This 
dialog opens when you click the Data Prep icon on the ERDAS IMAGINE icon panel 

  

  

Subset Image   Click to open the Subset dialog, 
which enables you to create and 
define a subset image.  

Image 
Geometric 
Correction 

  Click to open the Set Geo Correction 
Input File dialog, which is part of the 
Geometric Correction Tool. This 
dialog enables you to select the image 
you want to rectify.  

Mosaic 
Images 

  Click to open the Mosaic Tool, 
MosaicPro (PC Only), the Mosaic 
Wizard (PC Only), or the Mosaic 
Direct (PC Only), all of which enable 
you to mosaic two or more images 
together.  

Unsupervised 
Classification  

  Click to open the Unsupervised 
Classification dialog.  

 

 Reproject 
Images 

  Select this option to resample an 
image into a different projection. 

Basic Remote Sensing and GIS 

1. Introduction to Remote Sensing and ERDAS IMAGINE 1-15

Source: ERDAS IMAGINE® Tour Guides™. (2006). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC 
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Spectral Resolution
Spectral resolution refers to the specific wavelength intervals in the electromagnetic spectrum that a 
sensor can record (Simonett et al, 1983). 

Wide intervals in the electromagnetic spectrum are referred to as coarse spectral resolution, and 
narrow intervals are referred to as fine spectral resolution. For example, the SPOT panchromatic 
sensor is considered to have coarse spectral resolution because it records EMR between 0.51 and 
0.73. On the other hand, band 3 of the Landsat TM sensor has fine spectral resolution because it 
records EMR between 0.63 and 0.69 (Jensen, 1996).

Radiometric Resolution
Radiometric resolution refers to the dynamic range, or numbers of possible data file values in each 
band. This is referred to by the number of bits into which the recorded energy is divided. For 
instance, in 8-bit data, the data file values range from 0 to 255for each pixel, but in 7-bit data, the 
data file values for each pixel range from 0 to 128.

The sensor measures the EMR in its range. The total intensity of the energy from 0 to the maximum 
amount the sensor measures is broken down into256 brightness values for 8-bit data, and 
128brightness values for 7-bit data.  
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Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC.
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Source: ERDAS IMAGINE on line Help for the Link Viewers

Linking Viewers 
Select this option to link or unlink Viewer windows geographically so that the same image area 
opens in all linked Viewers. This type of link will not reflect changes in the arrangement of the 
layers, band combinations, or changes by other tools in the Viewer. Select this option again to 
unlink. 

a) In the first Viewer, select View | Link/Unlink Viewers | Geographical.  
The Link/Unlink Instructions display.  
 

b) Move your pointer to the second Viewer. The pointer becomes a Link symbol .  
 

c) Move the pointer to the first Viewer.  

d) The No Link symbol displays as the cursor in the first Viewer. Clicking in this Viewer 
discontinues the link operation.  

e) To link the Viewers, click anywhere in the second Viewer.  
 

 

f) The two Viewers are now linked. A white cursor box opens over the image in the second 
Viewer, indicating the image area displayed in the first Viewer.  
 

g) You can move and resize this cursor box as desired, and the image area in the first Viewer 
reflects each change. This is similar to the magnification box you used earlier. 

 
 
 
 

Viewer 1 
Viewer 2 

Two Viewers are
Geographically
linked 





 natural resource management 

 wildlife habitat protection 

 baseline mapping for GIS input 

 urban expansion / encroachment 

 routing and logistics planning for seismic / exploration / resource extraction activities 

 damage delineation (tornadoes, flooding, volcanic, seismic, fire) 

 legal boundaries for tax and property evaluation 

 target detection - identification of landing strips, roads, clearings, bridges, land/water 
interface 
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Land use and cover studies are multidisciplinary and the participants involved in such work are 
numerous and varied, ranging from international wildlife and conservation foundations, to 
government researchers, and forestry companies. The land use and land cover information are used 
for planning, monitoring, and evaluation of development, industrial activity, or land reclamation. 
The impacts of land-use and land-cover change on carbon dynamics, hydrology, climate change, and 
biodiversity have been recognized. Changes in land cover will be examined by environmental 
monitoring researchers, conservation authorities, and departments of municipal affairs, with interests 
varying from tax assessment to reconnaissance vegetation mapping. Remote-sensing data play an 
important role in land use and land cover mapping and in land use and land cover modeling for 
construction, parameterization, and validation. Following is the list of applications of land use and 
land cover mapping:  

Land use and Land Cover Mapping 
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Shape
Shape refers to the general form, structure, or outline of individual objects. It can be a very 
distinctive clue for interpretation. Straight edge typically represents urban or agricultural targets. On 
the contrary, natural features, such as forest edges, are generally, more irregular in shape. 
Agricultural fields irrigated by rotating sprinkler systems would appear as circular shapes.  

Size
It is important to assess the size of a target relative to other objects and the absolute size, to aid in 
the interpretation of that target. A quick approximation of target size can direct interpretation 
quickly. For example, large buildings such as factories or warehouses would suggest commercial 
property, whereas small buildings would indicate residential use.

4. Satellite Image Interpretation                                                                                                                     4-7

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing 

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing 
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Lesson Review

Knowledge and Skills Practice 2: Satellite Image Rectification

  What is rectification
  When to rectify and georeferencing satellite images.
  Rectification steps
  Geo-referencing in ERDAS IMAGINE
  Resampling methods 

The details of this assignment and data are given in the attached CD of the manual. 
Please follow the Knowledge and Skills Practice 2: Satellite Image Rectification. 
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Primary Colors
Blue, green, and red are the primary colors or wavelengths of the visible spectrum. No single primary 
color can be created from the other two primary colors, but all other colors can be formed by 
combining blue, green, and red in various proportions. The sunlight is actually composed of various 
wavelengths of radiation in primarily the ultraviolet, visible and infrared portions of the spectrum.

The infrared spectrum region covers the wavelength range from approximately 0.7mm to 100mm. 
This region can be divided into reflected IR and emitted or thermal IR based on the irradiation 
properties. 

The reflected IR region covers wavelengths from approximately 0.7mm to 3.0mm. This region is 
further divided into near IR (0.7mm–1.3mm) and mid IR (1.3mm–3mm). The near IR records 
energy related to vegetation health, while the mid IR is more related to moisture.

The thermal IR covers wavelengths from approximately 3.0mm to 100mm. The energy in this 

This microwave spect rum covers the longes t wave lengths of 
e lectromagnetic energy used for remote sensing. It covers the 
wavelength range from 1mm to 1m. The shorter wavelengths have 
properties similar to the thermal infrared region while the longer 
wavelengths approach the wavelengths used for radio broadcasts.

Because of their long wavelengths, microwaves have special properties 
that are important for remote sensing. Longer wavelength microwave 
radiation can penetrate through cloud cover, haze, dust, and all but the 
heaviest rainfall. This property allows detection of microwave energy 
under almost all weather and environmental conditions so that data can 
be collected at any time.

1. Introduction to Remote Sensing and ERDAS IMAGINE1-6

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.  

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.

Infrared Spectrum

Microwave Spectrum
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Source: ERDAS IMAGINE® Tour Guides™. (2006). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC

Image Interpreter 
 
 

This menu provides access to the ERDAS IMAGINE Image Interpreter functions. It opens 
when you click the Interpreter icon in the ERDAS IMAGINE icon panel 

  
 
Spatial 
Enhancement 

Click to access functions for enhancing 
images using the values of individual 
and surrounding pixels. The Spatial 
Enhancement menu displays. 

Radiometric 
Enhancement 

Click to access functions for enhancing 
images using the values of individual 
pixels within each band. The 
Radiometric Enhancement menu 
displays.  

Spectral 
Enhancement 

Click to access functions for enhancing 
images by transforming the values of 
each pixel on a multiband basis. The 
Spectral Enhancement menu displays.  

GIS Analysis Click to access functions for use on 
thematic data layers. The GIS Analysis 
menu displays.  

Utilities... Click to access some common utilities 
used on raster layers. The Utilities menu 
displays.  
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Temporal Resolution
Temporal resolution refers to how often a sensor obtains imagery of a particular area. For example, 
the Landsat satellite can view the same area of the globe once every 16 days. SPOT, on the other 
hand, can revisit the same area every three days. Temporal resolution is an important factor to 
consider in change detection studies. 

Digital Image Format in Remote Sensing
Satellite image data is available in the following four different formats:

TIFF: It stands for Tagged Image File Format. It is one of the most popular and flexible of the 
current public domain raster file formats. In TIFF files, information about the file structure is stored 
in so-called "tags".

GeoTIFF: is an emerging standard for storing georeferenced image data. It is widely supported in 
remote sensing and GIS software such as ERDAS Imagine, ENVI, ArcGIS etc.

The Hierarchical Data Format (HDF) is a multi-object file format for sharing scientific data in a 
distributed environment.

MrSid: It is a powerful wavelet-based compressor. This data enable instantaneous viewing and 
manipulation of massive images locally and over networks, while maintaining maximum image 
quality and manageability.   

2-6                                                                                  2. Satellite Image Characteristics and Viewer Function

Jensen 20007



Source: ERDAS IMAGINE on line Help for the Raster Attribute Editor
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Raster Attribute Editor 
The Raster Attribute Editor provides access to the properties saved in the Descriptor Table for 
each layer of a raster file. The Descriptor Table is part of the .img file. The Raster Attribute Editor 
allows you to edit, add, or delete attributes as well as perform functions with them. The changes 
effected by these operations can be saved with the image file. 

There are several ways to access the Raster Attribute Editor:  

Select Tools > Edit Raster Attributes... from the ERDAS IMAGINE icon panel.  

Select Edit > Raster Attribute Editor... from the ImageInfo menu bar. This method allows 
access to any layer of any .img file.  

Select Raster > Attributes... from the Viewer menu bar. This method operates on the layer open 
in ImageInfo. 

Edit Column Properties  
This dialog enables you to add, remove, and rearrange attribute columns. You may change the 
alignment and format of data and the width of columns. 

Click Edit > Column Properties... on the Raster Attribute Editor menu bar, or click the 
icon on the toolbar to access this dialog. 
 

 





 

 lithological mapping 
 structural mapping 
 sand and gravel (aggregate) exploration/ exploitation 
 mineral exploration 
 hydrocarbon exploration 
 environmental geology 
 baseline infrastructure 
 sedimentation mapping and monitoring 
 event mapping and monitoring 
 geo-hazard mapping 

 

 wetlands mapping and monitoring, 
 soil moisture estimation, 
 snow pack monitoring / delineation of extent, 
 measuring snow thickness, 
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Geology 
Geology involves the study of landforms, structures, and the subsurface, to understand physical 
processes creating and modifying the Earth's crust. Remote sensing is used as a tool to extract 
information about the land surface structure, composition or subsurface. Information on lithology 
or rock composition may be extracted from multispectral images based on spectral reflectance. 
Radar provides information of surface topography and roughness, and it is extremely valuable when 
integrated with another data source to provide detailed relief. Application of Remote Sensing in the 
field of Geology may include:

Hydrology
Abilities of remote sensing technology in hydrology are to measure spatial, spectral, and temporal 
information and provide data on the state of the earth's surface. It provides observation of changes 
in hydrological states, which vary over both time and space that can be used to monitor hydrological 
conditions and changes. Both active sensors that send a pulse and measure the return pulse (like 
radar, microwave etc.) and passive sensors that measure emissions or reflectance from natural 
sources (like Sun, thermal energy of the body) are used. Sensors can provide data on reflective, 
thermal and dielectric properties of earth's surface.

Remote sensing techniques indirectly measure hydrological variables, so the electromagnetic 
variables measured by remote sensing have to be related to hydrological variables empirically or with 
transfer functions. Application of remote sensing in the field of hydrology:   



  

 




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Lesson Review
Knowledge for Image Interpretation
Elements of Image Interpretation like Image Tone, Image Texture, 
Shadow, Patterns, Association, Shape, Size and their significance. 

4-8                                                                                                                     4. Satellite Image Interpretation
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When electromagnetic energy passes through atmosphere, it is scattered or absorbed mainly by 
particles and molecules of several gases (for example water vapor, carbon dioxide, and ozone) in the 
Earth's atmosphere. Some radiation, such as visible light, largely passes through the atmosphere. 

Atmospheric scattering occurs when particles (aerosols and dust particles) or large gas molecules in 
the atmosphere interact with electromagnetic radiation and cause it to be redirected from its original 
path. The amount of scattering depends on the wavelength of the radiation, the abundance of 
particles or gases, and the travel distance of the radiation.

Types of Scattering
Scattering is a function of the wavelength of the electromagnetic energy, the size of the gas 
molecule, dust particle and water vapor droplet encountered. There are three types of scattering:

Rayleigh scattering: Such phenomena occur when electromagnetic radiation interacts with particles 
which are very small compared to the wavelength of the radiation. Such particles are very small dust 
or nitrogen and oxygen molecules. In this process, shorter wavelengths of energy are scattered much 
more than longer wavelengths. It is the dominant scattering mechanism in the upper atmosphere.

Mie scattering: Such phenomena occur when electromagnetic radiation interacts with particles which 
are about the same size as the wavelength of the radiation. It occurs in the lower portions of the 
atmosphere where larger particles are abundant, and dominants when cloud conditions are overcast.   

1. Introduction to Remote Sensing and ERDAS IMAGINE 1-7

Interactions with the Atmosphere

Atmospheric Scattering



Image Classification 
 
 

Classification is the process of sorting pixels into a finite number of individual classes, or 
categories of data, based on their data file values. If a pixel satisfies a certain set of criteria, then 
the pixel is assigned to the class that correspond the set of criteria.  
 
For the first part of the classification process, the computer system must be trained to recognize 
patterns in the data. Training is the process of defining the criteria by which these patterns are 
recognized. The result of training is a set of signatures, which are criteria for a set of proposed 
classes. 

 
 
 
 
 
 
Source: 
ERDAS 

Signature 
Editor 

Unsupervised 
Classification 

Supervised 
Classification 
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click to open the Signature Editor. This 
utility allows you to create, manage, evaluate, 
edit, and classify signatures.  

There are two ways to classify pixels into different categories: supervised and unsupervised  Many 
of the Classification tools can also be accessed through the Signature Editor. 

This menu displays when you click the Classifier icon on the ERDAS IMAGINE icon panel.

Click to open the Unsupervised Classification 
d i a l o g . T h i s u t i l i t y l e t s y o u p e r f o r m a n 
unsupervised classification on an .img file 
using the ISODATA algorithm. This utility can 
also be accessed from the Signature Editor.

Click to open the Supervised Classification 
dialog. This utility allows you to perform a 
supervised classification on an .img file 
using various decision rules. This utility can 
also be accessed from the Signature Editor.

Source: IMAGINE® Tour Guides™. (2006). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC



Introduction to IMAGINE Viewer 

The ERDAS IMAGINE Viewer is the "main window" for displaying raster, vector, and/or 
annotation data. You can open as many Viewers as your window manager supports. Following are 
the IMAGINE viewer functions: 

 Using Utility Menu Options  The Utility menu on the Viewer enables you to access
four separate groups of functions; inquiry functions, 
measurement tool, layer viewing and information. Each 
function group is separated by a line in the pull down menu.

 Viewing Menu Options  The Viewing menu on the Viewer enables you to access
Arrange Layers, Zooming and Linking Viewers functions.

 Using Raster Menu Options  The Raster menu is available whenever a raster view pane 
is active.

 Using the Raster Attribute Editor  The Raster Editor enables you to edit portions of the
displayed image using various tools in the Viewer Raster 
menu. When a specific raster editing tool is in use, that 
tool locks the Viewer, therefore, work with one tool must 
be completed before opening another one.

 Using Profile Tools       The spectral profile display is fundamental to the analysis
of hyper-spectral data sets. As the number of bands 
increases and the band widths decrease, the remote sensor 
is evolving toward the visible/infrared spectrometer. The 
reflectance (DN) of each band within one (spatial) pixel 
can be plotted to provide a curve approximating the 
profile generated by a laboratory scanning spectrometer

Source: ERDAS IMAGINE on line Help file on Viewer  
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Source: ERDAS IMAGINE on line Help for the Spectral Profile Tools
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Spectral Profile Tools 
This dialog enables you to select which Profile Tool to open. It opens when you click the icon on 

the Viewer toolbar, , or when you select Raster > Profile Tools... from the Viewer menu bar. 
 

Select the Profile you want to view.  

 

 

Spectral - Select this option to open the Spectral Profile dialog.

Spatial - Select this option to view the Spatial Profile dialog.

Surface - Select this option to view the Surface Profile dialog.

OK - Click to view the selected profile and close this dialog.

Cancel - Click to cancel this process and close this dialog. 





 glacier dynamics monitoring (surges, ablation) 
 river /delta change detection 
 drainage basin mapping and watershed modelling 
 irrigation canal leakage detection 
 irrigation scheduling 

 

 

Oil spill 
 mapping and predicting oil spill extent and drift 
 strategic support for oil spill emergency response decisions 
 identification of natural oil seepage areas for exploration 

 

Fish stock and marine mammal assessment 
 water temperature monitoring 
 water quality 
 ocean productivity, phytoplankton concentration and drift 

 

Intertidal zone 
 tidal and storm effects 
 delineation of the land /water interface 
 mapping shoreline features / beach dynamics 
 coastal vegetation mapping 
 human activity / impact 
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Source: http://ces.iisc.ernet.in/energy/monograph1/Gispage7.html

Coastal Monitoring
The coastal zone is a region subjected to increasing stress from human activity and natural disasters. 
Government agencies concern with the impacts of human activities and natural disasters in this 
region need new data sources for monitoring erosion and accretion, loss of natural habitats, 
urbanization, land use and land cover, effluent sand offshore pollution. Many of the changes in the 
coastal region and dynamics of the open ocean can be mapped and monitored using remote sensing 
techniques. Major application includes:   

 determining snow-water equivalent, 
 river and lake ice monitoring, 
 flood mapping and monitoring, 
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Rectification................................................................................................................................5-2
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Objective
By the end of this lesson, through the knowledge and skills practice the participants 
will be able to:

1.  Define rectification.
2.  Explain when to rectify and geo-referencing satellite images.
3.  Explain the Rectification steps
4.  Geo-reference the satellite images using ERDAS Imagine software.
5.  Tell and describe the four resampling methods and explain their significance.
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Nonselective scattering: Such phenomena occur when electromagnetic radiation interacts with 
particles which are much larger (water droplets and large dust particles) than the wavelength of the 
radiation. In this process, all wavelengths are scattered about equally. 

The figure shows the relative size of the atmospheric particles that are responsible for various 
scattering of the electromagnetic radiation in the atmosphere.

Absorption causes molecules in the atmosphere to absorb electromagnetic energy at various 
wavelengths when it interacts with the atmospheric constituents. Ozone, carbon dioxide, and water 
vapor are the three main atmospheric constituents which absorb electromagnetic energy. Ozone 
absorbs the harmful ultraviolet radiation from the sun. Carbon dioxide, referred to as a greenhouse 
gas, absorbs radiation strongly in the far infrared portion of the electromagnetic spectrum which 
serves to trap this heat inside the atmosphere. The incoming long wave infrared and shortwave 
microwave radiation (between 22 and 1m) are absorbed by water vapor in the atmosphere.

Atmospheric windows: The regions of the electromagnetic spectrum, which are not severely 
influenced by atmospheric absorption and useful to remote sensing, are called atmospheric 
windows.  

1. Introduction to Remote Sensing and ERDAS IMAGINE1-8

Atmospheric Absorption

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.



   

Spatial Modeler 

Spatial Modeler enables you to create and run models for image processing and GIS analysis. It is 
a highly flexible tool that uses Model Maker and the Spatial Modeler Language.  
 
The Spatial Modeler Language is a modeling language that is used internally by Model Maker to 
execute the operations specified in the graphical models that you create. You can also use the 
Spatial Modeler Language directly to write your own script models.  
 
Click this icon on the ERDAS IMAGINE icon panel to access Spatial Modeler: 

 

Model Maker Click to open the Model Maker window and the Model Maker Tool 
palette. This window allows you to work with graphical models. You can 
view or edit existing models and create new models.  

Script Librarian Click to open the Model Librarian dialog. This dialog lists all the existing 
script models in the system. Using this option, you can view, edit, create, 
and delete script models.  
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Source: ERDAS IMAGINE® Tour Guides™. (2006). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC
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Parts of Viewer Window
The parts of the Viewer window are explained in the following illustration. Left - hold and drag any 
one of these corners to resize the Viewer. 

Source: ERDAS IMAGINE on line Help file on Viewer 

The Title Bar shows the number of the Viewer, which is referred to in other 
operations 

Left-hold on Viewer Menu Bar item for list of operations to perform on the 
displayed data 

The Tool Bar consists of icons to provide rapid access to frequently used 
operations 

Use Scroll Bars to scroll the data. The size of the bar in the panel shows how 
much of the data area you are viewing now. 

Right click inside the viewer to pop up a Quick View Menu of frequently used 
functions. 

Help for Viewer  Select this option to see this On-Line Help document 

Information about the button under the cursor is displayed in this Status Bar.
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AOI Tools 
The AOI Tools enable you to select, create, and edit areas of interest (AOIs). An AOI is a point, 
line, or polygon that is selected as a training sample or as the image area to be used in an 
operation. They are often used as input to the Signature Editor prior to image classification. 

This tool palette opens when you select AOI -> Tools... from the Viewer menu bar. 

 Click to select, move, and resize AOI elements.  

 Click to select all AOI elements that fall within the boundary of the 
rectangular marquee that you draw.  
 
  Click to create a rectangular AOI.  

 Click to create an elliptical AOI. 

 Click to create a polygonal AOI. Click to add each vertex. Double-
click to close the polygon. 

 Click to create a polyline AOI. In the Viewer, click to add each 
vertex. Double-click to end the polyline. 

 
Click to select a single pixel from which an AOI grows. 

 
Click to create a point AOI. 

AOI Tools 

Source: ERDAS IMAGINE on line Help for the AOI Tools 
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Lesson Review
Information about sensors, platforms, satellite orbit, satellite swath and 
multispectral scanning
Different types of satellites and their use
Different Earth Observation satellites and their significance.
Different applications of satellite image 



Rectification
Rectification is the process of transforming the data from one grid system into another grid system 
using a geometric transformation. To be able to compare separate images pixel by pixel, the pixel 
grids of each image must conform to the other images in the data base. 

Registration is the process of conforming an image to another image. For example, if image A is not 
rectified and it is being used with image B, then image B must be registered to image A so that they 
conform to each other. 

Geo-referencing refers to the process of assigning map coordinates to image data. The image data 
may already be projected onto the desired plane, but not yet referenced to the proper coordinate 
system.

Rectification involves geo-referencing, since all map projection systems are associated with map 
coordinates. Image-to-image registration involves geo-referencing only if the reference image is 
already georeferenced. Geo-referencing, by itself, involves changing only the map coordinate 
information in the image file. The grid of the image does not change.

When to Rectify ?
There are several reasons for rectifying image data:

comparing pixels scene to scene in applications, such as change detection or thermal inertia 
mapping (day and night comparison)

developing GIS data bases for GIS modeling � identifying training samples according to map 
coordinates prior to classification

creating accurate scaled photomaps and overlaying an image with vector data, such as ArcInfo 
�

comparing images that are originally at different scales 

extracting accurate distance and area measurements

mosaicking images and performing any other analyses requiring precise geographic locations

Before rectifying the data, you must determine the appropriate coordinate system for the data base.  

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC.  
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Introduction  
 

 

The manual on Basic Remote Sensing and GIS is for the trainees and trainers with 
different objectives. 

This manual has been designed as a resource tool for those who would be using 
remote sensing and GIS in their area of work. It is expected that the Basic Remote 
Sensing and GIS manual will substantially enhance the capacity of those who will be 
imparting information and knowledge on the same as Trainers, and develop the 
capacity of those Trainees to whom these information and knowledge will be 
imparted.

The Trainees or the participants of the training on RS & GIS will go –post training- 
through the manual in order to reinforce their learning of the fundamentals of the 
remote sensing processes, use of GIS and to apply the learnt skills, effectively.

The Trainers will go through this manual to make an assessment of their own 
knowledge and understanding of the subject, fill their own knowledge gaps on this 
subject matter, if found any, and decide on the suitable approach to present/facilitate 
knowledge and skills learning to the trainees, effectively. They may use this manual a 
support material for conducting sessions.

The contents of the manual are organized under 9(Nine) sections or Lessons. Each 
Lesson comprises a lecture [composed of several topics that cover the main subject of 
the Lecture] and an end-of-lesson knowledge and skills practice session wherever 
required. In addition, key objectives to be achieved after completion of each Lesson, 
have been stated clearly so that the user is focused on the learning being transferred 
through each lesson. Topic-wise detailed notes have also been included as 
supplementary information. Moreover, notes also include additional reference links. 
Knowledge and skills practice session is given with a view to help the users to assess 
what they learn from each lesson and explore the significance of ERDAS Imagine 
software and ArcGIS software in Remote Sensing and GIS.

In overall, this RS & GIS manual is intended to assist in developing human resource 
capacity for Bangladesh Forest Department through a clear understanding of and 
practice on basics of Remote Sensing and GIS concepts and their different 
applications. 
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Interaction with Targets
When energy incident upon the surface, three forms of interaction 
take place: absorption (A); transmission (T); and reflection 
(R).The proportions of each depends on the wavelength of the 
energy and the material and condition of the feature.

Absorption (A) occurs when energy is absorbed into the target. 
Transmission (T) occurs when radiation passes through a target and 
Reflection (R) occurs when radiation "bounces" off the target. In 
remote sensing, the radiation reflected from targets is measured.  

Specular Reflection: When a surface is smooth 
we get specular or mirror-like reflection where 
almost all of the energy is directed away from 
the surface in a single direction.
Diffuse reflection: such reflection occurs when 
the surface is rough and the energy is reflected 
almost uniformly in all directions. 

There are two extreme ends of the way in which energy is reflected from a target: specular 
reflection and diffuse reflection.

Interactions with Vegetation
Chlorophyll in leaves strongly absorbs radiation in the red and blue wavelengths but reflects 
greenwavelengths. That is why leaves appear green. It appears "greenest" in the summer, 
whenchlorophyll content is at its maximum. In autumn, there is less chlorophyll in the leaves, so 
there isless absorption and proportionately more reflection of the red wavelengths, making the 
leavesappear red or yellow.
The internal structure of healthy leaves act as excellent diffuse reflectors of near-infrared 
wavelengths. Measuring and monitoring the near-IR reflectance in remote sensing, one can 
determine how healthy (or unhealthy) vegetation may be. 

http://earthobservatory.nasa.gov/Features/Measuring Vegetation/measuring_vegetation_2.php 

1. Introduction to Remote Sensing and ERDAS IMAGINE 1-9
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Lesson Review
 Remote Sensing and its Process

 Electromagnetic energy and different regions of Electromagnetic spectrum

 Interaction of Electromagnetic energy with Atmosphere and targets.

 Passive and Active Remote Sensing

 Data Reception, Transmission and Processing

 Information about different image processing software

 Introduction to ERDAS IMAGINE software 
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In the Viewer menu bar, select File | Open | Raster Layer or Click  to open raster layer. 

 
 

Select Layer to Add : Select file type from File of Type dropdown list and select the raster data to open. 

Raster Options : Click on Raster Options and choose following raster options:

Display as :
True Color - appropriate for most interval or ratio multiband images; Pseudo Color - appropriate for 
nominal or ordinal images in one band; Gray Scale - appropriate for a single band of interval or ratio data.

Layer to color: Red :
Enter the band to display in the red color channel; Green: Enter the band to display in the green 
color channel; Blue: Enter the band to display in the blue color channel. 

Clear Display- When this checkbox is enabled, and a new image is loaded, the image currently 
displayed in the Viewer is removed. Disable this checkbox to overlay images. 

 Fit to Frame- If this checkbox is enabled, the image is magnified or reduced to fit the Viewer 
window at its current size. 

No Stretch- Click to display data without applying the normal two standard deviation stretch.  
Using - Use one of the following resampling methods: Nearest Neighbor, Bilinear Interpolation, 
Cubic Convolution, and Bi-cubic Spline.  

Displaying an Image 
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Satellite Image Data
Bands
Multispectral Satellite Image
Different types of Raster Layer
Different types of Resolution and their significance
Different format of Digital Images
Introduction of Image Viewer and its different functions. 

Lesson Review
 
 


 






 

The details of this assignment and data are given in the attached CD of the manual. 
Please follow the Knowledge and Skills Practice 1: Satellite Image Characteristics 
and Viewer Functions. 

Knowledge and Skills Practice 1: Satellite Image Characteristics and 
Viewer Functions 



 

 

 

 Burghausen, Germany Oahu, Hawaii 
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RapidEye
The RapidEye constellation of five Earth Observation satellites has been in 
operation since February 2009. The system images a 77 kilometer wide swath, 
which produces more than five million square kilometers of earth every day for 
its archive and over one billion km2 every year.RapidEye's sensors produce 
imagery in five spectral bands (Red, Green, Blue, Red Edge and Near Infrared). 

BlackBridge satellites include the Red-Edge band, which is sensitive to changes 
in chlorophyll content. Several studies have suggested that the transition 
between the red absorbance and the Near-Infrared (NIR) reflection is able to 
provide additional information about vegetation and its characteristics.

Satellite Specification
Number of Satellites: 5
Orbit Altitude: 630 km in Sun-synchronous orbit 
Sensor Type: Multi-spectral push broom imager
Global Revisit Time: 1 Day
Pixel size (ortho-rectified): 5 m
Swath Width: 77 km
Revisit time: Daily (off-nadir) / 5.5 days (at nadir) 
Dynamic Range: 12 bit 

Five Constellation Satellites (Image
Copyright © BlackBridge) 

Source : http://www.satimagingcorp.com/satellite-
 sensors/other-satellite-sensors/rapideye/ 

Source: BlackBridge. WHITE PAPER The RapidEye Red Edge Band
 https://earth.esa.int/web/guest/missions/3rd-party-missions/current-missions/rapideye
 http://www.satimagingcorp.com/satellite-sensors/other-satellite-sensors/rapideye/  

Spectral Bands
440 – 510 nm (Blue)
520 – 590 nm (Green)
630 – 685 nm (Red)
690 – 730 nm (Red Edge)
760 – 850 nm (Near IR) 

                  Typical spectral reflectance curves of selected surfaces inrelation to the RapidEye spectral bands

Source: BlackBridge. WHITE PAPER The RapidEye Red Edge Band. 



Basic Remote Sensing and GIS 

A Training Manual Prepared for Bangladesh Forest Department 

Satellite Image Interpretation 

Objective ................................................................................................................................... 4-1

Image Interpretation .................................................................................................................. 4-2

Knowledge for Interpretation....................................................................................................... 4-2

Image Interpretation Tasks........................................................................................................ 4-3

Elements of Image Interpretation................................................................................................ 4-4

Lesson Review............................................................................................................................ 4-8

Objective
By the end of this lesson, the participants will be able to:

1. Explain the knowledge for interpretation of satellite image
2. Explain fully the elements of image interpretation.  



When to Geo-reference ?
Scanning and digitizing produce images that are planar, but do not contain any map coordinate 
information. These images need only to be georeferenced. In many cases, the image header can 
simply be updated with new map coordinate information. This involves redefining the:

· map coordinate of the upper left corner of the image

· cell size (the area represented by each pixel)

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC. 

Disadvantages of Rectification
During rectification, the data file values of rectified pixels must be resembled to fit into a new grid 
of pixel rows and columns. Although some of the algorithms for calculating these values are highly 
reliable, some spectral integrity of the data can be lost during rectification. If map coordinates or 
map units are not needed in the application, then it may be wiser not to rectify the image. An 
unrectified image is more spectrally correct than a rectified image

Classification
Some analysts recommend classification before rectification, since the classification is then based on 
the original data values. Another benefit is that a thematic file has only one band to rectify instead of 
the multiple bands of a continuous file.

On the other hand, it may be beneficial to rectify the data first, especially when using GPS data for 
the GCPs. Since these data are very accurate, the classification maybe more accurate if the new 
coordinates help to locate better training samples.

Thematic Files
Nearest neighbor is the only appropriate resampling method for thematic files.

Rectification Steps
Usually, rectification is the conversion of data file coordinates to some other grid and coordinate 
system, called a reference system. Rectifying or registering image data on disk involves the following 
general steps, regardless of the application. 

1. Locate GCPs. 

2. Compute and test a transformation. 

3. Create an output image file with the new coordinate information in the header. The pixels
must be resampled to conform to the new grid.

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC 
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Introduction to GIS Concept
and its Application 

Objective ................................................................................................................................ 7-1

What is GIS ? (Geographic Information System) ................................................................... 7-2

How Data is Organized in GIS ............................................................................................ 7-5

Introduction to ArcGIS ......................................................................................................... 7-7

ArcMap................................................................................................................................. 7-10

Application of GIS................................................................................................................ 7-12

Lesson Review........................................................................................................................ 7-15

Knowledge and Skills Practice 4: Introduction to GIS Concept and its application .................. 7-15

By the end of this lesson, through the knowledge and skills practice the participants 
will be able to:  

1.  Define what GIS is and its components.
2.  Explain how data is organized in GIS.
3.  Explore ArcGIS software and its capabilities.
4.  Explain the application of GIS.
5.  Open the different tools of ArcCatalog and ArcMap viewer.  

Objective 
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Interactions with Water
Water absorbs longer visible wavelength and near infrared radiation than shorter visible 
wavelengths. That is why water typically looks blue or blue-green due to stronger reflectance at 
shorter visible wavelengths, and darker if viewed at red or near infrared wavelengths.

Because of more absorption of the blue wavelengths and reflection of the green wavelengths by 
chlorophyll in algae, the water appears greener in color when algae are present in water. If there is 
suspended sediment in the upper layers of the water body, this will allow higher reflectivity and a 
brighter appearance of the water.

Spectral Response
A spectral response for an object can be built up by measuring the energy that is reflected or emitted 
from the object on the Earth's surface over a variety of different wavelengths.

By comparing the response patterns of different features over a variety of different wavelengths, it is 
possible to distinguish between them. For example, water and vegetation may reflect somewhat 
similarly in the visible wavelengths but are almost always separable in the infrared.

Spectral response for the same target type can be quite variable even it can vary temporally and 
spatially. Understanding the factors, which influence the spectral response of the object of interest, 
are critical to correctly interpreting the interaction of electromagnetic radiation with the object.

1. Introduction to Remote Sensing and ERDAS IMAGINE1-10

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.
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You can query a displayed image for information about each pixel using the inquiry functions. 
 
1. Select Utility | Inquire Cursor from the Viewer menu bar.  

 
A white crosshair displays in the Viewer and the Inquire Cursor dialog opens.  
 
There are three methods when using the Inquire Cursor in the Viewer;  
 
Drag the white crosshair over the image and, enter new coordinates into the Cell Array of the 
Inquire Cursor dialog. The Inquire Cursor moves when you move the mouse cursor back into 
the Viewer. As the crosshair is moved, the information in the Inquire Cursor dialog 
automatically updates.  

 
2. The Cell Array in the Inquire Cursor dialog reports a variety of pixel information. Drag on the 

horizontal scroll bar (or enlarge the Inquire Cursor dialog by dragging any corner) to show all 
of the pixel information available in the Cell Array. 

 

 
 
 

 
 
 
 

 
 

Source: ERDAS IMAGINE on line Help for the Inquire Cursor

Inquiry Cursor Function 
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LANDSAT 8
LANDSAT 8 satellite sensor is part of the Landsat Data Continuity Mission was successfully 
launched on February 11, 2013 from Space Launch Complex-3, Vandenberg Air Force Base in 
California and will join LANDSAT 7 satellite in orbit.

LANDSAT 8 satellite has two main sensors: the Operational Land Imager (OLI) and the Thermal 
Infrared Sensor (TIRS).OLI will collect images using nine spectral bands in different wavelengths of 
visible, near-infrared, and shortwave light to observe a 185 kilometer (115 mile) wide swath of the 
Earth in 15-30 meter resolution covering wide areas of the Earth's landscape while providing 
sufficient resolution to distinguish features like urban centers, farms, forests and other land uses. 

TIRS was added to the satellite mission when it became clear that state water resource managers rely 
on the highly accurate measurements of Earth's thermal energy obtained by LDCM's predecessors, 
LANDSAT 5 and LANDSAT 7, to track how land and water are being used. With nearly 80 percent 
of the fresh water in the Western U.S. being used to irrigate crops, TIRS will become an invaluable 
tool for managing water consumption. 

Source: http://www.satimagingcorp.com/satellite-sensors/other-satellite-sensors/landsat-8/ 
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Image Interpretation
Image Interpretation is "The examination of images for the purpose of identifying objects and 
judging their significance". (McClone, 2004).

We must apply a specialized knowledge to translate images into information. The specialized 
knowledge forms the field of image interpretation and we can apply this knowledge to derive useful 
information from the images. Image interpretation involves the identification of various targets 
(environmental or artificial features) from images which consist of points, lines, or areas.

Targets may be defined in terms of the way they reflect or emit radiation. This radiation is measured 
and recorded by a sensor, and ultimately is depicted as an image product such as an air photo or a 
satellite image. 

Knowledge for Interpretation 
Proficiency of image interpretation is formed by three separate kinds of knowledge:  

Subject
Knowledge of the subject of interpretation is the heart of the interpretation. Accurate interpretation 
requires familiarity with the subject of the interpretation. For example, interpretation of geologic 
information requires education and experience in the field of geology. Yet narrow specialization is a 
handicap, because each image records a complex mixture of many kinds of information, requiring 
application of broad knowledge that crosses traditional boundaries between disciplines.

Geographic Region
Knowledge of the specific geographic region depicted on an image can be equally significant. Every 
locality has unique characteristics that influence the patterns recorded on an image. In unfamiliar 
regions the interpreter may find it necessary to make a field reconnaissance or to use maps and 
books that describe analogous regions with similar climate, topography, or land use.

Remote Sensing System Subject
Different instruments use separate portions of the electromagnetic spectrum, operate at different 
resolutions, and use different methods of recording images. The image interpreter must know how 
each of these variables influences the image to be interpreted and how to evaluate their effects on 
his or her ability to derive useful information from the imagery. 

Source: 
Wynne, James B. Campbell, Randolph H. (2011). Introduction to remote sensing (5th ed.). New York: Guilford Press.
Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.  

Source:
Wynne, James B. Campbell, Randolph H. (2011). Introduction to remote sensing (5th ed.). New York: Guilford Press



Ground Control Points
GCPs are specific pixels in an image for which the output map coordinates (or other output 
coordinates) are known. GCPs consist of two X,Y pairs of coordinates:  

Source Coordinate
Usually data file coordinates in the image being rectified is known as Source Coordinates

Reference Coordinate
The coordinates of the map or reference image to which the source image is being registered is 
known as Reference Coordinates  

GCP in ERDAS IMAGINE
Any ERDAS IMAGINE image can have one GCP set associated with it. The GCP set is stored in 
the image file along with the Raster layers.

In the Cell Array of GCP data that displays in the GCP Tool, one column shows the point ID of 
each GCP. The point ID is a name given to GCPs in separate files that represent the same 
geographic location. Such GCPs are called corresponding GCPs.

A default point ID string is provided (such as GCP #1), but you can enter your own unique ID 
strings to set up corresponding GCPs as needed. Even though only one set of GCPs is associated 
with an image file, one GCP set can include GCPs for a number of rectifications by changing the 
point IDs for different groups of corresponding GCPs.  

Entering GCPs
Select many GCPs throughout the scene. The more dispersed the GCPs are, the more reliable the 
rectification is. GCPs for large-scale imagery might include the intersection of two roads, airport 
runways, utility corridors, towers, or buildings. For small scale imagery, larger features such as urban 
areas or geologic features may be used. Landmarks that can vary (e.g., the edges of lakes or other 
water bodies, vegetation, etc.) should not be used. 

The source and reference coordinates of the GCPs can be entered in the following ways:

·  They may be known as priori, and entered at the keyboard.

·  Use the mouse to select a pixel from an image in the Viewer. With both the source and
destination Viewers open, enter source coordinates and reference coordinates for image-to
image registration.

·  Use a digitizing tablet to register an image to a hardcopy map. 
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Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC





GIS is the acronym for geographic information system. It is an integrated collection of compu ter software and data used to view and manage information about geographic places, analyze spat ial relationships, and model spatial processes. A GIS provides a framework for gathering a nd organizing spatial data and related information so that it can be displayed and analyzed.  
 
Example: 
 

 Information about places on the Earth’s surface.  
– e.g. population of a country 

 Knowledge about where something is  
– e.g. locations of fishing villages 

 Knowledge about what is at a given location 
– e.g. bio-diversity of habitats 

 
Characteristics of geographic information 

 Can be very detailed e.g. individual trees in a forest 
 Can be very coarse e.g. climate of a region 
 Mostly static e.g. natural and manmade features does not change rapidly 
 Can be moving e.g. vehicles, ships, aero planes 
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What is GIS? (Geographic Information System)

Sources:
http://en.wikipedia.org/wiki/Geographic_information_system
http://resources.arcgis.com/en/help/ 

a database management system (DBMS)  
tools for the input and manipulat ion of 
geographic information
tools that support geographic query, analysis, 
and visualization 
a graphical user interface (GUI) for easy 
access to tools 

Software : GIS software provides the functions 
and too ls needed to s tore , ana lyze , and d i sp lay 
geographic information. Key software components are

Hardware : Hardware is the computer on which a 
GIS operates. Today, GIS runs on a wide range of 
hardware types, from centralized computer servers 
to desktop computers used in s tand-a lone or 
networked configurations.

Components of a GIS
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What is RemoteSensing ? ........................................................................................................ 1-2

Electromagnetic Radiation ....................................................................................................... 1-3

Interactions with the Atmosphere ............................................................................................. 1-7

Interaction with Targets ........................................................................................................... 1-9

Imagine Processing Software .................................................................................................... 1-12

Introduction to ERDAS Imagine ........................................................................................... 1-12

Lesson Review ......................................................................................................................... 1-19

By the end of this lesson, the participants will be able to:

1.  Define Remote Sensing and describe its process, correctly.
2.  Identify and interpret the different region of Electromagnetic spectrum, 

correctly.
3.  Explain the interaction of electromagnetic energy with atmosphere and targets.
4.  Interpret the Spectral response pattern of different features of earth surface.
5.  Delineate the Recording of energy by the sensor.
6.  Recognize the different image processing software
7.  Give an outline of the different functions of ERDAS IMAGINE software. 

Objective 
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Recording of Energy by the Sensor
The sun is a convenient source of energy for remote sensing. The sun's energy is either reflected, as 
it is for visible wavelengths, or absorbed and then reemitted, as it is for thermal infrared 
wavelengths.

Passive Remote Sensing : In passive remote sensing systems, the reflected and emitted energy that is 
naturally available are measured by sensors. The reflected energy is available during the time when 
the sun is illuminating the Earth and naturally emitted energy such as thermal infrared is available at 
day or night for remote sensing.

Active Remote Sensing : active remote sensing system, the energy that is required for remote sensing 
is provided by its own energy source. The sensor transmits energy toward the target to be 
investigated and the energy reflected from that target is detected and measured by the sensor. Some 
examples of active sensors are laser fluorescence and synthetic aperture radar (SAR). 

Data Reception, Transmission, and Processing
Data acquired from satellite platforms are electronically transmitted to the Earth. There are three 
main options for transmitting data acquired by satellites to the surface. The data can be directly 
transmitted to Earth if a Ground Receiving Station (GRS) is in the line of sight of the satellite or the 
data can be recorded on board the satellite (B) for transmission to a GRS at a later time. Data can 
also be relayed to the GRS through the Tracking and Data Relay Satellite System (TDRSS) which 
consists of a series of communications satellites in geosynchronous orbit. 

1. Introduction to Remote Sensing and ERDAS IMAGINE 1-11
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Satellite Image Characteristics
and Viewer Functions 

Objective.................................................................................................................................. 2-1
Satellite Image Data................................................................................................................ 2-2
Raster Layers.......................................................................................................................... 2-3
Resolution................................................................................................................................ 2-4
Digital Image Format in Remote Sensing................................................................................. 2-6
Introduction to IMAGINE Viewer........................................................................................ 2-7
Lesson Review.......................................................................................................................... 2-19
Knowledge and Skills Practice1: Satellite Image Characteristics and Viewer Functions............. 2-19

Objective
By the end of this lesson, through the knowledge and skills practice the participantswill 
be able to:  

1.  State what is Satellite Image data, Bands ?
2.  Explain how multispectral image are formed.
3.  Differentiate between different types of raster layer.
4.  Describe different types of resolution and its significance.
5.  Identify digital image format in remote sensing.
6.  Explore the Image viewer and its different functions using          
    ERDASIMAGINE software.
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This dialog gives you tools for taking many kinds of measurement in a Viewer.  
Select Utility > Measure... from the Viewer menu bar or click the  icon in the Viewer tool 
bar to open this tool. 

 Click to disable the current Measurement Tool.  

 Click to measure points in the displayed image. Click in the Viewer to designate the point. 
The point coordinates are reported in the text window.  

 Click to measure lengths and angles in the displayed image. Click in the Viewer to add each 
vertex. Double-click or middle-click (depending upon how your preferences are set) to 
end the polyline. The polyline length and azimuth (heading) are reported in the text 
window. 

 Click to measure perimeters and areas in the displayed image. Click in the Viewer to add 
each vertex. Double-click or middle-click (depending upon how your preferences are set) 
to close the polygon. The polygon perimeter and area are reported in the text window.  

Source: ERDAS IMAGINE on line Help for the measurement tools

Measurement Tools



 

 

Satellite Sensors and Platform and Application 
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Objective ................................................................................................................................ 3-1 

What is a Sensor ? ................................................................................................................ 3-2 

Platforms ............................................................................................................................... 3-2

Different Types of Satellite ..................................................................................................... 3-5 

Earth Observation Satellites .................................................................................................. 3-6 

Forestry Application .............................................................................................................. 3-11

Agriculture Application ......................................................................................................... 3-14

Land use and Land Cover Mapping ...................................................................................... 3-15

Geology .................................................................................................................................. 3-16

Hydrology .............................................................................................................................. 3-16

Coastal Monitoring ................................................................................................................ 3-17

Lesson Review ....................................................................................................................... 3-18  

Objective
By the end of this lesson, the participants will be able to:

1.  Define what a Sensor is.
2. Define what are Platforms, Satellite Orbit, Satellite Swath, and Multispectral
    Scanning.
3.  Delineate different types of satellite and its uses.
4.  Talk about all the Earth Observation Satellites introduced in the lesson.
5.  State different application of satellite images 
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Forestry Application
Forests are a valuable resource providing food, fuel, shelter, wildlife habitat and daily supplies. It 
plays an important role in balancing the Earth's CO2 supply and exchange. The main issues 
concerning forest management are depletion due to natural causes or anthropogenic activity, and 
monitoring of health and growth for effective commercial exploitation and conservation.

Remote Sensing applications in forestry include sustainable forest resources development, 
biodiversity, monitoring deforestation and reforestation, and managing commercial logging 
operations, watershed protection, biophysical monitoring and other environmental concerns 

  Reconnaissance mapping: 
- forest cover type discrimination
- agroforestry mapping 

  Commercial forestry:
- clear cut mapping / regeneration assessment
- burn delineation
- infrastructure mapping / operations support
- forest inventory
- biomass estimation
- species inventory 

  Environmental monitoring
- deforestation (rainforest, mangrove colonies)
- species inventory
- watershed protection (riparian strips)
- coastal protection (mangrove forests)
- forest health and vigour  
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Image Interpretation Tasks
The image interpreter must routinely conduct several kinds of tasks, many of which maybe 
completed together in an integrated process. Nonetheless, for purposes of clarification, it is 
important to distinguish between these separate functions

Classification
Classification is the assignment of objects, features, or areas to classes based on their appearance on 
the imagery.

Enumeration
Enumeration is the task of listing or counting discrete items visible on an image. 

Measurement
Measurement is the task of measuring distance and height and, by extension, of volumes and areas 
as well. A second form of measurement is quantitative assessment of image brightness.

Delineation
Separate distinct areal units that are characterized by specific tones and textures and to identify 
edges or boundaries between separate areas. Typical examples include delineation of separate classes 
of forest or of land use—both of which occur only as aerial entities (rather than as discrete objects).

 Classification Enumeration 

  
Measurement Delineation 

  
 
Source:
Wynne, James B. Campbell, Randolph H. (2011). Introduction to remote sensing (5th ed.). New York: Guilford Press



Polynomial Transformation
Polynomial equations are used to convert source file coordinates to rectified map coordinates. The order 
of transformation is the order of the polynomial used in the transformation. ERDAS IMAGINE allows 
1st- through nth-order transformations. Usually, 1st-order or 2nd-order transformations are used.

Transformation Matrix
A transformation matrix consists of coefficients is computed from the GCPs. The goal in calculating 
the coefficients of the transformation matrix is to derive the polynomial equations for which there is 
the least possible amount of error when they are used to transform the reference coordinates of the 
GCPs into the source coordinates.

Linear Transformations
A 1st-order transformation is a linear transformation

Nonlinear Transformations
Transformations of the 2nd-order or higher are nonlinear transformations. These transformations 
can correct nonlinear distortions.  

RMS Error
RMS error is the distance between the input 
(source) location of a GCP and the retransformed 
location for the same GCP. In other words, it is 
the difference between the desired output 
coordinate for a GCP and the actual output 
coordinate for the same point, when the point is 
transformed with the geometric transformation. 

RMS error is expressed as a distance in the source 
coordinate system. If data file coordinates are the 
source coordinates, then the RMS error is a 
distance in pixel widths. For example, an RMS 
error of2 means that the reference pixel is 2 pixels 
away from the retransformed pixel.  
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Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC 



  

Decision Rule 

Parametric Decision Rule 
 

A parametric decision rule is trained by the parametric signatures. These signatures are defined by 
the mean vector and covariance matrix for the data file values of the pixels in the signatures. When 
a parametric decision rule is used, every pixel is assigned to a class since the parametric decision 
space is continuous (Kloer, 1994).  
Nonparametric Decision Rule 
 

A nonparametric decision rule is not based on statistics; therefore, it is independent of the 
properties of the data. If a pixel is located within the boundary of a nonparametric signature, then 
this decision rule assigns the pixel to the signature’s class. Basically, a nonparametric decision rule 
determines whether or not the pixel is located inside of nonparametric signature boundary. 
 

Output File 
 When classifying an image file, the output file is an image file with a thematic raster layer. This file 
automatically contains the following data: 

� class values 
� class names 
� color table 
� statistics 
� histogram 

The image file also contains any signature attributes that were selected in the ERDAS IMAGINE 
Supervised Classification utility. 

 
 
 
 

 
 Thematic Layer is associated with a Raster 

Attribute Table 
 Each pixel is associated with a class value  
 Each category is assigned a specific color 
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After the signatures are defined, the pixels of the image are sorted into classes based on the 
signatures by use of a classification decision rule. The decision rule is a mathematical algorithm that, 
using data contained in the signature, performs the actual sorting of pixels into distinct class values.  
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Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC. 



Attribute: Attribute is spatial or 
nonspatial information about a 
geographic feature in GIS, usually 
stored in a tabular form and linked 
to the feature by a unique identifier. 
For example, attributes of a river 
might include its name, length, and 
sediment load at a gauging station. 
In Raster datasets, information 
associated with each unique value 
of a Raster cell. 
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Source: http://resources.arcgis.com/en/help/

 Source:http://www.innovativegis.com/basis/BeyondMappingSeries/BeyondMapping_IV/Topic8/BM_IV_T8.htm 

Source: http://slideplayer.com/slide/5682848/ 

Data: Maybe the most important component of a GIS is the data. Geographic data and related 
tabular data can be collected in-house or bought from a commercial data provider. Most GISs 
employ a DBMS to create and maintain a database to help organize and manage data.

People: GIS technology is of limited value without the people who manage the system and to 
develop plans for applying it. GIS users range from technical specialists who design and maintain 
the system to those, who use it for their everyday works.

Procedures: A successful GIS operates according to a well-designed plan and business rules, which 
are the models and operating practices unique to each organization.

Presentation: Presentation is the final output of any GIS analysis. Anybody can present their GIS 
data both in paper map or digital format.  

GIS Concepts 
GIS is used to represent the real world. For 
examp le , i n r e a l i t y a p l a ce i s s t a cked by 
different layers like Roads, Forests, Water and 
Houses. This layer has different characteristics 
l i k e d e n s e f o r e s t o r l e s s d e n s e f o r e s t , 
ownership of house etc. Using GIS, you can 
extract this layer with its characterist ics. 
Finally, you can represent all layers in a map  
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What is Remote Sensing ?

Remote sensing is the science and art of acquiring information about the Earth's surface without 
actually being in contact with it. This is done by sensing and recording reflected or emitted energy 
from earth surface and processing, analyzing, and applying that data.

“Remote sensing is the practice of deriving information about the earth’s land and water surface using 
images acquired from an overhead perspective, using electromagnetic radiation in one or more regions 
of the electromagnetic spectrum, reflected or emitted from the earth’s surface.” (Campbell et.al., 2011)

Satellite Technology is an example of remote sensing.

Of our five senses, sight, hearing and smell, may be considered as forms of remote sensing. 

Remote Sensing Process
The remote sensing process involves an interaction between incident radiation and the targets of 
interest. The following seven elements as shown in the figure are involved with the process. 

Energy Source or Illumination (A)
The first requirement for remote sensing is to have an energy source which illuminates or provides 
electromagnetic energy to the target of interest.

Radiation and the Atmosphere (B) 
The energy will come in contact with and interact with the atmosphere, as the energy travels from its 
source to the target. 

1. Introduction to Remote Sensing and ERDAS IMAGINE 1-2 
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Image Processing Software
There are different types of software that are used in Remote Sensing to Process image, image 
interpretation, geo-referencing, classification, image enhancement and also data analyzing, as well as 
map composing. The following software is usually used in remote sensing:

ERDAS IMAGINE It is the world’s best leading geospatial data authoring software. ERDAS 
IMAGINE is a remote sensing application with raster graphics editor abilities designed by ERDAS 
for geospatial applications.

ENVI has the latest processing and analysis tools that help to extract meaningful information to 
make better decision using panchromatic, LiDAR, SAR and multispectral or hyperspectral imagery. 

eCognition
eCognition Developer is a powerful development environment for object-based image analysis. It is 
used in earth sciences to develop rule sets for the automatic analysis of remote sensing data

ArcGIS Esri’s ArcGIS is a geographical information system (GIS) for working with maps and 
geographic information. It is used for creating and using maps, on screen digitization, compiling 
geographic data, analyzing mapped information, sharing and discovering geographic information, 
using maps and geographic information in a range of applications and managing geographic 
information in a database.

Introduction to ERDAS Imagine
ERDAS IMAGINE is a remote sensing application with raster graphics editor abilities designed by 
ERDAS for geospatial applications. ERDAS IMAGINE is aimed primarily, at geospatial raster data 
processing and allows the user to prepare, display and enhance digital images for mapping use in 
geographic information system (GIS) or in computer-aided design (CAD) software. It is a toolbox 
allowing the user to perform numerous operations on an image and generate an answer to specific 
geographical questions. 

1. Introduction to Remote Sensing and ERDAS IMAGINE1-12

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC.
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Satellite Image Data
An image is a digital picture or representation of an object on the Earth Surface. Image data are stored 
in image files on magnetic tapes, computer disks, or other media. The data consist only of numbers. 
These representations form images when they are displayed on a screen or are output to hardcopy.

Pixel and Digital file value
Each number in an image file is a data file value, which are sometimes referred to as pixels. The term 
pixel is abbreviated from picture element. It is the smallest part of a picture with a single value. The data 
file value is the measured brightness value of the pixel at a specific wavelength. 

Raster image data are arranged in a grid similar to the squares on a checkerboard. Each cell of the 
grid is represented by a pixel, also known as a grid cell. In remotely sensed image data, each pixel 
represents an area of the Earth at a specific location. The data file value assigned to that pixel is the 
record of reflected radiation or emitted heat from the Earth’s surface at that location. Data file 
values may also represent elevation, as in digital elevation models (DEMs). 

Bands
Image data may include several bands of information. Each band is a set of data file values for 
aspecific portion of the electromagnetic spectrum of reflected light or emitted heat (red, green, blue, 
near-infrared, infrared, thermal, etc.) or some other user-defined information created by combiningor 
enhancing the original bands, or creating new bands from other sources. 

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC.
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Layer Info 
This dialog enables you to view and edit many elements of a raster image file (*.img), including 
statistics, map information, and projection information. Select Utility > Layer Info... from the 
Viewer menu bar to access this dialog. This dialog may contain one or more of the following tabs: 

General This tab contains the File info, Layer info, Statistics info, Map info and 
Projection info. 

 

Projection  This tab displays the projection information if it is present in the image.  
 

Histogram This tab shows the image histogram without the need to open a second dialog.
 

Pixel data This tab contains a table showing the pixel values for the current data band 
 

File History This tab contains user comments describing changes to the image. 
 

Elevation Info This tab contains the elevation information for the image. 
 

GCP Table This tab displays the ground control points collected from a TIFF file an
used to populate the tag. 

 

TIFF Info This tab allows you to view the values of the tags associated with key
associated with a TIFF file.  

 

 This information should be modified with caution because of ERDAS
IMAGINE programs. 





Deforestation between 1967 and 2007 
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Deforestation
Deforestation increases soil erosion, river siltation and deposition, affecting navigation, fisheries, 
wildlife habitat, and drinking water supplies, as well as farming productivity and self-sufficiency. It 
also affects the genetic diversity of species, which controls our intrinsic ability to adapt to changing 
conditions and environment. 

The rate and extent of deforestation and monitoring regeneration can be measured by remote 
sensing technology. Using multi-temporal satellite data, forest cover change detection analyses can 
be carried out. Radar, merged with optical data, can be used to efficiently monitor the status of 
existing clear cuts or emergence of new ones, and even assess regeneration condition. Remote 
sensing data provide a view of areas which are remote and inaccessible.

Derived from IRS P6 LISS III Satellite Image acquired in 2007Derived from Corona Image acquired in 1967
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Source:
Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing
Wynne, James B. Campbell, Randolph H. (2011). Introduction to remote sensing (5th ed.). New York: Guilford Press.

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing

Elements of Image Interpretation
Observing the differences between targets and their backgrounds involves comparing different 
targets based on any, or all, of the visual elements of Image Tone, Image Texture, Shadow, Pattern, 
Association, Shape, Size and Site. Identifying targets in remotely sensed images based on these visual 
elements allows us to further interpret and analyze. 

Image Tone
Tone refers to the relative brightness or color of objects in an image. It is the fundamental element 
for distinguishing between different targets or features and variations in tone allows the elements of 
shape, texture, and pattern of objects to be distinguished. For black-and-white images, tone may be 
characterized as “light,” “medium gray,” “dark gray,” “dark,” and so on, as the image assumes varied 
shades of white, gray, or black. For color or CIR imagery, image tone refers simply to “color,” 
described informally perhaps in such terms as “dark green,” “light blue” or “pale pink”. 



Resampling Methods  
Since the grid of pixels in the source image rarely matches the grid for the reference image, the 
pixels are resampled so that new data file values for the output file can be calculated. 

The following resampling methods are supported in ERDASIMAGINE: 

Nearest Neighbor - uses the value of the closest pixel to assign to the output pixel value.

Bilinear Interpolation - uses the data file values of four pixels in a 2 × 2 window to calculate an 
output value with a bilinear function.

Cubic Convolution - uses the data file values of sixteen pixels in a 4 × 4 window to calculate an 
output value with a cubic function.

Bicubic Spline Interpolation - fits a cubic spline surface through the current block of points.  

Nearest Neighbor
To determine an output pixel’s nearest neighbor, the rectified coordinates of the pixel are 
retransformed back to the source coordinate system using the inverse of the transformation. The 
pixel that is closest to the retransformed coordinates is the nearest neighbor. The data file value(s) 
for that pixel become the data file value(s) of the pixel in the output image. 

Transfers original data values without averaging them as the other methods do. This is an important 
consideration when discriminating between vegetation types, locating an edge associated with a 
lineament, or determining different levels of turbidity or temperatures in a lake (Jensen, 1996).

This method is suitable for using before classification. This is the easiest of the three methods to 
compute and the fastest to use.   
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Ground Truthing
Ground truthing refers to the acquisition of knowledge about the study area from field work, 
analysis of aerial photography, personal experience, etc. Ground truth data are considered to be the 
most accurate (true) data available about the area of study. They should be collected at the same time 
as the remotely sensed data, so that the data correspond as much as possible. However, some 
ground data may not be very accurate due to a number of errors and inaccuracies.  

  

 

• Must be useful 
• Must be detectable using the data you have 
• Should be hierarchical 
• Categories must be mutually exclusive 
• Require explicit definitions of each class 

 

 

Steps of Supervised Classification 
 Selecting Training Samples 
 Collecting Signatures from Training 

Samples 
 Evaluating Signatures 
 Perform classification process 
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Source:  ERDAS Field Guide™. (2005). Norcross,
 Georgia:Leica Geosystems Geospatial Imaging, LLC. 

Classification Scheme

Supervised Classification 

Usually, classification is performed with a set of target classes in mind. Such a set is called a 
classification scheme (or classification system).

The purpose of such a scheme is to provide a framework for organizing and categorizing the 
information that can be extracted from the data (Jensen et al, 1983).

A number of classification schemes have been developed by specialists who have inventoried a 
geographic region. A classification scheme should possess the following characteristics: 

Supervised classification requires a priori (already known) information about the data, such as: 

What types of classes need to be extracted? Soil type? Land use? Vegetation? What classes are most 
likely to be present in the data? That is, which types of land cover, soil, or vegetation (or whatever) 
are represented by the data ? 

In supervised training, you rely on your own pattern recognition skills and a priori knowledge of the 
data to help the system determine the statistical criteria (signatures) for data classification. To select 
reliable samples, you should know some information—spatial or spectral—about the pixels that you 
want to classify. The location of a specific characteristic, such as a land cover type, may be known 
through ground truthing.   
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Representation of Objects in GIS
T h e f o l l o w i n g f i g u r e g i v e s a n i d e a h o w y o u 
represent an object like a house in GIS. If you draw 
the boundary of this house then it gives the spatial 
location of this house in this space. Now you can 
add additional information within the attribute of 
this feature (house) like house ID, owner, address, 
registration date etc.  

Following are the two big questions that can be answered by GIS:

a)  Where is what? (Obtain information from a location)
For Example, Bariyadala is one of the ranges of Chittagong North Division. If you know the 
spatial location of Bariyadala Range, you will find detailed information of this Range. You will 
explore lots of information like number of Beats in this Range, total plantation area, plantation 
year, open spaces etc.

b)  What is where? (Query information to find location)
Similarly, you have a GIS dataset of Forest Administrative Unit. Now, you know there is a 
Range by the name Bariyadala and it falls within the Chittagong North Division but you do not 
know the location of this Bariyadala Range. If you query Bariyadala Range within the GIS 
datasets of Forest Administrative Unit using the above information, you will find the spatial 
location of Bariyadala Range. 

Probable Fields of GIS Application  Urban planning :

Especially for area monitoring (both on a sectoral and integral basis), regional potential and 
feasibility analyses and site selection studies, land management and land use planning issues. 

Environmental Science: Monitoring environmental risks, management of watersheds, floodplains, 
wetlands, aquifers, groundwater modeling and contamination tracking, hazardous or toxic facility siting.

Utility planning and civil engineering: Geographic information system (GIS) technology 
provides the tools for creating, managing, analyzing, and visualizing the data associated with 
developing and managing infrastructure.

Business: Business network design, location based services, ESRI BIS Portfolio software run 
reports, make maps and profile your customers from your desktop with the versatile combination of 
data and software.  

GIS Applied: Two Big Questions
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Interaction with the Target (C)

After traveling through atmosphere, the energy interacts with the target depending on the properties 
of both the target and the radiation.

Recording of Energy by the Sensor (D): 

We require a remote sensor to collect and record the electromagnetic radiation after the energy has 
been scattered by, or emitted from the target. Transmission, Reception, and Processing (E):

After recording energy by the sensor, it is transmitted to a receiving and processing station where 
the data are processed into an image.

Interpretation and Analysis (F)

The image is visually or digitally interpreted to extract information about the target which was 
illuminated.

Application (G)

We apply the extracted information in order to better understand it, reveal some new information, 
or assist in solving a particular problem.  

Electromagnetic Radiation is a form of energy that is reflected or emitted from objects in the form 
of electrical and magnetic waves. It can travel through space. The electromagnetic radiation has 
fundamental properties and behaves in predictable ways according to the basics of the Wave 
Theory.

Electromagnetic radiation consists of an electrical field (E) and magnetic field (M). The electric field 
varies in magnitude in a direction perpendicular to the direction in which the radiation is traveling. 
The magnetic field (M) oriented at right angles to the electrical field. Both these fields travel at the 
speed of light (C).  

1. Introduction to Remote Sensing and ERDAS IMAGINE 1-3

Electromagnetic Radiation

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing. 

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing.  
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ERDAS IMAGINE Icon Panel
The main icon panel comes up when you start ERDAS IMAGINE. All functions in ERDAS 
IMAGINE are launched from this icon panel, or from the Viewer that also opens when ERDAS 
IMAGINE starts. The words Session, Main, Tools, Utilities, and Help display on the icon panel 
menu bar that lead to the ERDAS IMAGINE Session Manager, IMAGINE tools, general utilities, 
and On-Line Help 

Click to create a new Viewer. A Viewer is a visualization tool for displaying raster, 
vector, AOI, and annotation layers.

Click to import raster and vector data into ERDAS IMAGINE, or to export ERDAS 
IMAGINE files. The Import/Export dialog opens 

Click to display the Data Preparation menu which provides ao a set of tools that are 
useful in general data preparation. This includes Image Mosaicking, Image Rectification, 
Create Surface 

Click to bring up the Image Interpreter dialog. Many common image enhancement and 
manipulat ion operations are avai lable in Image Interpreter , including spatia l 
enhancement, radiometric enhancement, spectral enhancement, GIS analysis, and 
various utilities. 

Click to access the ERDAS IMAGINE Classification capabilities, enabling you to 
perform supervised or unsupervised image classification.  

Click to bring up the Spatial Modeler dialog. The Spatial Modeler allows you to perform 
many GIS algebra and GIS modeling operations using Model Maker and the Spatial 
Modeler Language.

1. Introduction to Remote Sensing and ERDAS IMAGINE 1-13

Source: ERDAS IMAGINE® Tour Guides™. (2006). Norcross,
 Georgia: Leica Geosystems Geospatial Imaging, LLC
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Multispectral Image
We can combine and display bands or channels of information digitally using the three primary 
colors (blue, green, and red). The data from each channels represented as one of the primary colors 
and, depending on the relative brightness of each pixel in each channel, the primary colors combine 
in different proportions to represent different colors. 

Raster Layers
When data are imported into ERDAS IMAGINE image files, they can contain two types of raster layers.
Continuous raster layers contain quantitative (measuring a characteristic on an interval or ratio scale) 
and related, continuous values. It can be multiband (e.g. Landsat TM data) or single band (e.g., SPOT 
panchromatic data).The following types of data are example.
Thematic data are raster layers that contain qualitative, categorical information about an area. 
Thematic layers lend themselves to applications in which categories or themes are used. Thematic 
raster layers are used to represent data measured on a nominal or ordinal scale, such as soils, land use, 
land cover, roads, and hydrology etc.

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC.  

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC.

Continuous Raster Layers Thematic Raster Layers
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Arrange Layers 
This dialog is an interactive 'stacker' tool for arranging multiple layers that are opened in a Viewer, 
or map frames and map annotation in a map composition.  

Each opened layer is represented by a bar in a scrolling list. The top of the stack represents the 
top, or most visible layer in the Viewer. Lower layers are obscured by any opaque regions in higher 
layers.  
 

This dialog opens when you select View > Arrange Layers from the Viewer menu bar or Map 
Composer menu bar.  
 

(stacker) Left-hold on any bar in the stack, and drag it to a new location in the stack. The 
following options are used with any layer in the stacker.  
 

Apply - Click to change the arrangement of layers in the Viewer or Map Composer according to 
your changes in this dialog. This button is disabled until you have edited the stack.  
 

Reset -Click to reset the layers to their original positions. This button is disabled until you have 
edited the stack.  
 

Up - This button is not enabled until you select Frame Options > Descend Into in a map frame 
layer. It allows you to move up out of the map frame level and into the default state of the 
Arrange Layers dialog.  
 

Close - Click to close this dialog without arranging layers.  
 

Help - Click to see this On-Line Help document.    

 

 
 
 
 

Source: ERDAS IMAGINE on line Help for the Arrange Layers
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Forest Cover Typing and Species Identification
Forest cover types and species identification are critical to both forest conservation managers and 
forestry companies interested in their supply inventory. Remote sensing technology provides a 
means of quickly identifying and delineating various forest types, a task that would be difficult and 
time consuming using traditional ground surveys. Both imagery and the extracted information can 
be incorporated into a GIS to further analyze. Hyperspectral imagery can provide a very high spatial 
resolution and extremely fine radiometric resolution data. This can be used to generate signatures of 
vegetation species and certain stresses on trees.
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Image Texture
Texture refers to the arrangement and frequency of tonal variation in particular areas of an image. 
Smooth textures are most often the result of uniform, even surfaces, such as fields, asphalt, or 
grasslands. A target with a rough surface and irregular structure, such as a forest canopy, results in a 
rough textured appearance. Texture is one of the most important elements for distinguishing 
features in radar imagery.  

Shadow
Shadow is helpful in interpretation relative height of a target or targets. It is also useful for 
enhancing or identifying topography and landforms, particularly in radar imagery. It can be used to 
distinguish clouds and snow.

It can reduce interpretation in their area of influence, since targets within shadows are much less or 
not at all discernible from their surroundings. 

 

 

 

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing

Source: Canada Centre for Remote Sensing. 2007. Tutorial: Fundamentals of Remote Sensing



 
 
 
 
 
 
 
 
 
 
 
 

Bilinear Interpolation 
In bilinear interpolation, the data file value of the rectified pixel is based upon the distances 
between the retransformed coordinate location and the four closest pixels in the input (source) 
image. Output pixels are an average of the nearest 4 original pixels. Results in output images that 
are smoother, without the stair stepped effect that is possible with nearest neighbor. 
 
Since pixels are averaged, bilinear interpolation has the effect of a low frequency convolution. 
Edges are smoothed, and some extremes of the data file values are lost. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC  
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Problems : Original pixel value integrity lost; slower 

Benefits : More spatially accurate; smooth transitions

Uses : Natural landscapes and environments  

Problems : Pixel duplication and drop-out

Benefits : Original pixel value maintained

Uses : Urban areas; data to be classified; thematic data  
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Selecting Training Samples
Training samples (also called samples) are sets of pixels that represent what is recognized as a 
discernible pattern, or potential class. The system calculates statistics from the sample pixels to 
create a parametric signature for the class.

Training sample and Training field

Training sample is a set of pixels selected to represent a potential class. Training field, or training 
site, is the geographical AOI in the image represented by the pixels in a sample. 

The selection of training samples depends largely upon your knowledge of the data, of the study 
area, and of the classes that you want to extract. ERDAS IMAGINE enables you to identify training 
samples using one or more of the following methods:

·   using a vector layer
·   defining a polygon in the image
·   identifying a training sample of contiguous pixels with similar spectral characteristics
·   identifying a training sample of contiguous pixels within a certain area, with or without
    similar spectral characteristics
·   using a class from a thematic raster layer from an image file of the same area (i.e., the
    result of an unsupervised classification) 

– Locate the training samples for 
each potential class and define 
their boundaries.

– Two or more samples may be 
selected for one potential class. 

Source: ERDAS Field Guide™. (2005). Norcross, Georgia: Leica Geosystems Geospatial Imaging, LLC.



 
Geographic data is organized as 

– collection of thematic layers linked by geographic coordinates 
– each thematic layer contains attributes 

 
Thematic layer describes any particular theme of any specific area like 
a land use or land cover data contain different thematic layers like 
water, vegetation, bare land etc. 
 
The quantities of latitude and longitude which define the position of a 
point on the surface of the Earth with respect to the reference 
spheroid.  
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Source:
http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture02/concepts/01%20How%20a%20GIS
%20map%20is%20organized.html  

Health care: Develop a Web-based GIS for Emergency Health Care Service provisions for Specific 
region, epidemiological studies like tracking the source of diseases.

Real estate: GIS helps the real estate industry to analyze, report, map, and model the merits of one 
site or location over another.

Hydrology: GIS helps to delineate drainage network, identify catchment area, delineate waterlogged 
area, identify groundwater mining zone.

Others: GIS is also used in many other sectors like Radio planning in Telecommunication sector.  

Types of Geographic Data Representation
In GIS, geographic data can be represented by vector representation and raster representation   

Raster representation
Represents any feature as a surface divided into regular grid of cells. Raster models are useful for 
storing data that varies continuously, as in an aerial photograph, a satellite image, a surface of 
chemical concentrations, or an elevation surface. 

Vector representation
Represents any features using points, lines and polygons. Vector models are useful for storing data 
that has discrete boundaries, such as country borders, land parcels, and streets. Represents the 
geographic features similar to the way maps do. A geometric element defined by a pair of x and y 
coordinates. 

On a map, a shape is defined by a connected series of unique x,y coordinate pairs. A line may be 
straight or curved. A closed shape is defined by a connected sequence of x,y coordinate pairs, 

How Data is Organized in GIS 



 

 

 

  
Point: Beat Office Line: River Network Polygon: Administrative Boundary 

Types of geographic data by Vector Representation 
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Discrete data and continuous data constitute the majority 
of raster data , which are a lso the main types of data 
resulted in raster analyses. In many ways, raster data 
complement vector data in GIS applications. Integration of 
both ras ter and vector data has therefore become a 
common feature in a GIS project.

This f igure shows a compar i son between the vector 
representation and raster representation of geographic data:   

Raster representation
o  Raster represents the real world as a regular grid of
     cells called pixel.

o  Cells are laid out in a grid and each cell has a
     location and a value describing the feature 

Raster data may be: 

Discrete data, also called categorical data, as in land-use maps or soils maps;

Continuous data, as in DEMs, rainfall maps, or pollutant concentration maps;

Satellite images or digital pictures, which are usually used as base maps for digitization or 
registration, but rarely used in raster analyses. 

where the first and the last coordinate pair are the same and all other pairs are unique. Various 
geographic features in vector representation are shown in the following figures:  

Source: http://support.esri.com/en/knowledgebase/GISDictionary/search



 

 ArcView  
 ArcEditor  
 ArcInfo 

 

     ArcView: 

 
     ArcEditor:

 
 ArcInfo: 
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Source: http://resources.arcgis.com/en/help/ 

Source: http://gis.stackexchange.com/questions/57142/what-is-the-difference-between-vector-and-raster-data-models

Both Vector and Raster data constitute of "latitudes and longitudes", only. The difference is in the 
way they are displayed. Latitudes and Longitudes in Vector data are displayed in the form of lines, 
points, etc. Latitudes and Longitudes in Raster data are displayed in the form of closed shapes where 
each pixel has a particular latitude and longitude associated with it.  

ArcGIS is professional GIS for desktop. Desktop GIS refers to a GIS that can be installed on a 
desktop computer. It aims to provide the user the GIS analysis, query with mapping facilities. 
Following is the list of some of the major capabilities of ArcGIS:
– Creates data and edits geographic and tabular data analysis and analyses map features
– Locates any map features from its attribute table
– Query and analyze data
– Examine and establish geographic relations between sets of data
– Reflects changes in maps when there are changes in the data
ArcGIS is Comprehensive, integrated, scalable system for a wide range of GIS users. It is a 
collection of software products that runs on desktop computers. There are 3 products in ArcGIS 
Desktop collection each having a higher level of functionality 

ArcView is the entry level licensing level of ArcGIS Desktop, a geographic information system software 
product produced by ESRI. It is intended by ESRI to be the logical migration path from ArcView 3.x. 

ArcEditor is the midlevel software suite designed for advanced editing of spatial data published in 
the proprietary ESRI format. It is part of the ArcGIS product. It provides tools for the creation of 
map and spatial data used in Geospatial Information Systems. ArcEditor is not intended for 
advanced spatial analysis, which can be performed using the highest level of ArcGIS, ArcInfo. 

ArcInfo (formerly ARC/INFO) is a full-featured geographic information system produced by ESRI, 
and is the highest level of licensing (and therefore functionality) in the ArcGIS Desktop product 
line. It was originally a command-line based system. The command-line processing abilities are now 
available through the GUI of the ArcGIS Desktop product.

Introduction to ArcGIS



• Geodatabases  
• Raster files  
• Map documents, globe documents, 3D scene documents, and layer files  
• Geoprocessing toolboxes, models, and Python scripts  
• GIS services published using ArcGIS for Server  
• Standards-based metadata for these GIS information items  
• And much more … 

ArcCatalog is used to: 
 Organize your GIS contents  
 Manage geo-database schemas  
 Search for and add content to ArcGIS applications  
 Document your contents  
 Manage GIS servers  
 Manage standards-based metadata 

In ArcCatalog there are 3 tabs : Contents, Preview and Description. 

Contents tab in ArcCatalog: 
 The Contents tab shows a list of the selected items. 

 
 
 
When you select items from the Catalog tree, the Contents tab lists the items they contain such as 
maps or tables. You can display the Contents list in several ways by using the buttons on the 
Standard toolbar to change its appearance. The view you are using is saved and used again after 
switching to a different tab or restarting ArcCatalog. 

 
 
 
 
 
 
 
 
Source: http://resources.arcgis.com/en/help/  

Large Icons view  
List view  
Details view  
Thumbnail view  
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ArcCatalog
The ArcCatalog application provides a catalog window that is used to organize and manage 
various types of geographic information for ArcGIS for Desktop. The kinds of information that 
can be organized and managed in ArcCatalog include:  
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Source: http://resources.arcgis.com/en/help/

The Description tab contains the metadata of selected data. 
Information that describes items in ArcGIS is called Metadata. 
ArcGIS offers several different metadata styles. If you want to 
view more information about the item or describe it in more 
detail than you can with the default Item Description Style, 
choose a different Metadata Style.
Select Customize >ArcCatalog options 

The Desc r ip t ion t ab w i l l g i ve you acce s s to 
documentation about the selected item. Using the 
E d i t b u t t o n , y o u c a n c r e a t e , e d i t a n d v i e w 
documentation of this data.

In ArcGIS 10.1 version, you wil l also see the data 
inGlobe View and 3D View.

The Preview tab shows the data in both geographic and tabular view 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
  
 
 
 
 
 
 
 
 
 
 
 

Editing 

 

Queries 
 

Analysis 

Graphing 
 

Reporting 
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ArcMap
In ArcMap, you can create and manipulate data sets to include a variety of information. For 
example, the maps produced in ArcMap, generally include features such as north arrows, scale bars, 
titles, legends, etc. The software package includes a style-set of these features.

Maps created and saved within ArcMap will create a file on the hard drive with an .mxd extension. 
Once an .mxd file is opened in ArcMap, the user can display a variety of information, as long as it 
exists within the data set. At this time the user will create an entirely new map output and use the 
customization and design features to create a unique product. Upon completion of the map, 
ArcMap has the ability to save, print, and export files to PDF or any other format. 

Source: http://resources.arcgis.com/en/help/

ArcMap user can edit their data using Editor toolbar.  Editing includes different types 
of editing, like creating new file, cutting and splitting polygon, merging polygon. Editor 
toolbar edits both spatial data and tabular data. 

A report lets user organize and display the tabular data that is associated with the 
geographic features.
The two native file formats for reports in ArcGIS are RDF (Report document file) and 
RLF(Report layout file)  

ArcMap user can analyze data using different spatial analysis toolbar from the Arc 
Toolbox. 
ArcMap user can create graph using the tabular data of any spatial datasets.

ArcMap user can query any information using the attribute table of selected data. 



ArcToolbox 
 

• Used for advanced GIS analysis  
• Used for geographic data processing 
• Used for creating and integration of a variety of data 

formats 
• Provides a powerful set of geoprocessing functions 

 

ArcToolbox is an integrated application developed by 
Environmental Systems Research Institute (ESRI). It 
provides a reference to the toolboxes to facilitate user 
interface in ArcGIS for accessing and organizing a collection 
of geoprocessing tools, models and scripts.  

 

A Tool box is a container which contains all the tools 
required to perform any advanced task in a particular 
domain. Similarly, ArcToolbox is a container in which all the 
tools required to facilitate advanced Geoprocessing tasks are 
organized in a logical way. All the Toolboxes, Toolsets and 
Tools within the ArcToolbox are sorted alphabetically. 

 
Common toolboxes present within ArcToolbox are:  
 

• Analysis Toolbox  
• Cartography Toolbox  
• Conversion Toolbox  
• Coverage Toolbox  
• Data Management Toolbox  
• Geocoding Toolbox  
• Linear Referencing Toolbox  
• Spatial Analyst Toolbox  

 
Source: http://resources.arcgis.com/en/help/  
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Mapping 
 

• Land use/Land cover map of any forest area is very much useful to see the spatial 
distribution of the forest area. With the help of GIS software like ArcGIS, you can easily 
extract these classes from Satellite Images or Aerial Photo. 
  
• For example, RapidyEye Image is a multispectral satellite image. Its spatial resolution is 5 

meter. Now you can easily identify the different classes like plantation, shrub and grass etc. 
The user can verify this classes using Ground Truth data and prepared a land use/land 
cover map of this area 
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Application of GIS 



Forest Monitoring 
 

A coal based thermal plant will be established near Mongla port in Bagherhat district, 
Bangladesh. The coal is to be transported through the Passur River. It may create negative 
impact around the forest area of this transportation route. For that reason it is necessary to 
monitor the forest health of specific plots within the forest area. These plots were selected 
based on distance from proposed project, coal transportation route, protection of the 
permanent sample plot and cover the maximum vegetation types.    

There are four sites to monitor the forest health.  
Waypoints of these sites were collected by GPS.  
After that Shapefile was created using ArcGIS software.  
The different observation was included as an attribute of this Shapefile.  
 

The attribute table of  mean value of Canopy Cover (%), Aboveground Carbon, Basal area, 
Seedling density, Pneumatophore, Lichen (%),Top Dying  <50 %, Top Dying  > 50 %, Timber 
Damage  <50 %, Timber Damage  >50 % with 95% confidence interval of one transact site 
given in two separate tables.
  
You can easily add field and insert value of subsequent monitoring data in this attribute table. 
This will help to evaluate the relative attribute value of this temporal data 

 
 

  

Location of Plot Profile of Transect line 
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Delineate Forest Boundary 
 
Delineating boundary of any feature is a challenging task. If you have any satellite image or 
aerial photo of any forest area, you can delineate the forest boundary. 
  
At first identify the boundary corner of this forest area. \ 
 
Now, you can collect GPS or DGPS (Differential Global Positioning System) of this corner and 
extract the polygon boundary according to the GPS or DGPS point. 
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Lesson Review
GIS and its components
Organization of data in GIS
Introduction of ArcGIS
Application of ArcGIS
Application of GIS 

Knowledge and Skills Practice 4: Introduction to GIS Concept and its 
application  

The details of this assignment and data are given in the attached CD of the manual. 
Please follow the Knowledge and Skills Practice 4: Introduction to GIS Concept 
and its application.





























  

 
There are two tools for interactive display, namely: Identity tool and Find tool. 
 
Identity Tool: 
 
This Identify Tool when clicked, allows display of the attributes for any feature. You can just use 
identity tool and click any feature. You will see information of this feature. For example, A linear 
feature was found within forest area of land use/land cover map. If you want to know the detailed 
information of this linear feature, select Identity Tool and click in the Linear feature. 
 
Find Tool: 
 
This tool allows you to find the feature from the large database. You can just click in Find Tool. 
Find Tool appeared and enter the information that you want to find in the Findrow and select the 
layer where you find this feature from the Inrow. Select Field from In Field and click Find. The 
finding information will be displayed. Right click of the information, a context menu appears with 
the different options like flash, zoom to feature, identify features, set bookmarks, select features 
and unselect features etc. 
 

  
 

 
  

  
Application of Identify tool Application of Find tool 
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Interactive Display
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